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Crash on Launch Hot Patches Released

The following hot patches have
been released eliminating over
98% of the crash on launch
issues that were introduced on
Mac for a handful of customers
earlier this year. Release dates
and builds for the hot patches
appear on the right.

Beta Builds

Beta builds for Cobalt, Xenon
and Argon v8 were added to the
website in July along side those
for Windows. As of this writing
they are v8 SPO BETA Build 811a
for Windows and Mac.

These Mac builds are for Power
PC with OS X.The universal
binary version to support the
Intel chip on Mac is now in early
beta testing among a few select
users and will be released for
public beta shortly.
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Product Version Build | Date
Graphite v7 SP3 788 June 22,2007
A
' i“ v8 SPO 812 August 8,2007
DY 4
Cobalt, v v7 SP2 616 August 8,2007
Xenon, @ /
Argon
A v8 SPOBETA | 811 August 16,2007

p
é% ANO

The Design Explorer

In the meantime the Windows
builds can be used under the
Parallels 3.0 or Boot Camp
emulation on the Intel Mac. At this
time we know that the precise
hidden line option in Model

to Sheet and the dimensional
constraints do not work in the
PPC Mac versions.
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New Address

Our Austin office has a new
mailing address:

Ashlar-Vellum

9600 Great Hills Trail
Suite 150W-1575
Austin, TX 78759 USA

Our European office address
remains the same.

We have become a virtual

1-(800) 877-2745 | www.Ashlar-Vellum.com

address gives us excellent access
to training facilities and office
space when we need it.

In the process we've been
installing a new telephone
system.We apologize if you've
had difficulty reaching us.It has
been most frustrating to us as
well.You can now dial the same
telephone numbers as usual:

organization working from
personal offices anywhere
around the world.This new

+1 800 877 2745 toll free
+1512 250 2186 local
+1 928 396 9992 fax

Curve/Surface Projection Tool Enhanced

The Curve/Surface Projection
tool in the upcoming v8 of
Cobalt, Xenon and Argon
supports imprinting profiles
onto surfaces and solids to
create surface subdivisions.

The Through mode projects a
curve on a surface that intersects
the entire object.

Select the Curve/Surface
Projection tool from the Surface
Utilities tool palette

and these options

appear in the message line:

+ Through
+ To Entity The To Entity option projects a
« To Face curve where it first touches the

object.

Use the To Face mode to project
a curve only on the specified
face.
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New People

Ashlar-Vellum is growing again,
adding new team members to
keep up with the demands of
our customers.

Georgiy
Sokolov grew
up and went
to school in
Kiev.He likes
sports and is
an avid Rubik’s
N cube collector,
especially those of higher levels
of difficulty and unusual shapes.
He’s also an active cyber-sport
participant.

)

)

Alexandr
Sapozhnik
is from
Chernivtsi in
southwestern
Ukraine. After
studying
applied physics
at Kiev Polytechnic he worked
for two other companies as a
programmer before joining
our Cobalt development team.
Alexandr likes sports, films and
books, and especially taking
walks with his friends.

)

Andrey
Mazyr studies
computer
science at Kiev
University of
Civil Aviation.
His place on

Ashlar-Vellum User Newsletter

our Cobalt team is his first job
as a programmer. He's a music
student, especially the guitar,
and likes sports and reading.
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Glevaha, a small town not

far from Kiev.Taras’ former
experience in construction,
building maintenance and as
a locksmith makes him well

) TarasKiselov suited as a draftsperson for our
was the first Snap-on project.Taras is inclined
new hire toward serious philosophical
especially for discussions regarding books and
our Snap-on art-house films. He also enjoys
team.Tar'as journaling.

\_ Jagrewupin

~

Parallels has just released
build 4560 of the Parallels
Desktop version 3.0.
Offering high performance
3D graphics support, this
new version works well
with Cobalt, Xenon and
Argon v7 and with all

the v8 betas, including
support for the real-

time environment maps.
This allows users to run
Microsoft Windows in a
window under Mac OS X,
on the Intel Mac.

Previous builds of version
3.0 interfered with the
Drafting Assistant, but this
build tested well running
Windows XP. Vista has not
been specifically tested.

Parallels 3.0 Now Works with
Ashlar-Vellum Software

Also available is VMware
Fusion.This emulation product
is still in beta and has similar
performance to Parallels 2.0
which for Cobalt, Xenon and
Argon is acceptable.

The best bet for great graphic
performance running Cobalt,
Xenon, Argon or Graphite on
the Mac Intel is still Boot Camp
from Apple.

The Design Explorer
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When Tech Support Can’t Reproduce Your Problem

There’s nothing more
frustrating than getting

an email back from tech
support saying in effect,”"We
have tested the issue on
three machines in our office
and cannot reproduce the
problem.”

Your reaction is probably the
desire to reach through your
network cable and strangle
someone.

At Ashlar-Vellum we realize
that just because we can't
reproduce a problem, it
doesn’t mean you're not
seeing it. Please understand
that MOST technical support
tickets are specific to
individual users. Other than
registration code issues, there
are very few problems that
affect more than 2% of our
user population, and therefore
there are rarely pat answers
that can be given.

So how can you help us help
you to solve the problem?

When our tech support team
cannot reproduce a problem it
stems from either one of two
reasons:

1. The problem is specific to
your system, situation or
set up.

2. We don't completely
understand the problem.

Let’s talk about how to make
further progress toward
solving each of these.

4 Third Quarter 2007

Your Specific Setup

The settings and configuration of
your personal system, network or
other setup may be causing you
grief while using Ashlar-Vellum
software. This could be related to
your hardware configuration, the
characters used in your file names,
and how often your software is
updated.We'll explore each of
these further.

The Design Explorer

System Configuration

Problems that manifest
themselves while using Ashlar-
Vellum software could be related
to the various graphics and
network driver revision levels,
the kind of file system on the
hard drive you're using, or your
network protocols. It is extremely
helpful to send us complete
information on your system.
Instructions for doing this on
each platform follow.

Continued...
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Mac System Info

1. Click on the Appleiconin
the upper left corner.

2. Go to About this Mac.
3. Click the More Info... button.

4. Inthe System Profiler use
File>Save As and save the
information as a plain text
file. Be sure to include your
name and operating system
as part of the file name.

Windows System Info

1. Follow Start>All Programs>
Accessories>System
Tools>System
Information.

2. Thenuse

File>Export to
save a text file
with your name
and operating
system as part of
the file name.

Ashlar-Vellum User Newsletter

File Names

File names also present a
number of problems. Anything
other than a-z and 0-9, can break
file names and paths. Upper
and lower case characters may
cause unpredictable results
on various systems. Extended
character sets used in most
languages other than English,
are handled differently by
different applications, file
systems, desktop
operating systems,
network operating
systems and network
protocols. Individually,
applications, file systems,
operating systems,
protocols and network
operating systems all
say they support paths
of over 2000 characters.
In reality, when all these things
are expected to work in concert
together, sometimes the
maximum is only 230 characters,
based on some parameter, set by
somebody, somewhere.

The Design Explorer
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Isolated Systems

Computers that have been
specifically isolated from the
internet for security reasons
cause our users major headaches
because they are not regularly
running system updates to keep
current with driver, operating
system and other updates.
Because of technology advances
we must sometimes become
incompatible with old systems
in order to support current
ones. It is imperative that you
connect your system to the
internet at least quarterly for
system updates. Getting timely
update CDs from Apple or
Microsoft is neither expedient
nor inexpensive.

Also, it is important that your
system be connected to the
internet in order to receive our
support emails and to participate
in screen-sharing sessions when
necessary.This is discussed
further on in this article.

Help Us Understand

When we can’t reproduce a
problem you can bet money that
it is not a common problem that
everyone else is having.So how
can you help us see it?

In addition to a complete
description of the specific
problem or function that is not
working, it is incredibly helpful
to attach a screen shot, movie,
translation or source file for us to
see.

Continued...
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Screen Captures

Grabbing a quick screen shot of
dialog boxes, the drawing area,
the warning message, the cursor
or whatever is the offending
issue can be enormously helpful
to our team. Even when you've
carefully articulated exactly what
the problem may be, if just one
detail is left out the issue may
not be visible to our team. A
screen capture shows enormous
details that are difficult to write
in an email.

To make a screen capture on a
Windows system:

1. Press the Print Screen
button.This saves the screen
to the clipboard.

2. Open Paint (included free
with Windows) using Start>
Programs>Accessories>
Paint.

3. Paste the screen capture into
the document.

4. Use Save As and save it
with a meaningful file name,
including your name and
operating system.

On the Macintosh:

1. Use Apple Key+Shift+3 for
the whole screen, or Apple
Key+Shift+4 to drag the
mouse across and capture a
specific screen area.
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2. This saves a numbered PDF
file to your desktop with a
filename such as Picturel.
PDF.

3. Rename the file with a
meaningful file name,
including your
name and
operating system.

When emailing a

screen capture DO NOT

simply paste it into an

email. Most graphics

pasted into the body

of an email cannot

be interpreted on

anything but your own system.
Follow the rules in the section
below on how to email a file.

Drawing Source and Log
Files

When you're experiencing
difficulty with a system crash,

it is imperative that you send a
drawing file to us.In addition,
starting with v7 of Cobalt, Xenon
and Argon and v8 of Graphite,
all programs generate a crash
log file that can be easily sent to
our support department. With
the help of the log, the detailed
steps that led to the crash,

and the drawing file you were
running prior to the crash, we
are usually able to provide both
a timely work around to the
problem and later, a full software

The Design Explorer
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solution. Follow the rules in the
section below on how to email
a file.

Translation Files

The single biggest frustration
occurs when
customers email us
reporting a problem
with file import or
export but do not
attach the files for us
to look at. Whenever
possible, please send
us all of the following:

* The native file in
which the data
was created.

* The intermediate file and
format from which you've
received or sent the data.

* A screen capture of the
result.

* The goal you are trying
to achieve by using the
translated data.

Translation problems are
absolutely specific to the
software and system on which
they are created, the contents of
the file, the other software you're
trying to translate to or from,and
various other factors. Without
the offending files we haven't
the first clue what’s wrong with
your result or where to begin to
solve the problem.

Continued...
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For example, you may be trying
to import data created in an
older version of Catia into
Graphite using a file sent to you
by a colleague that was printed
as a PDF and converted in
Acrobat to an EPS file. Depending
on your goal, the EPS file may or
may not be appropriate.If you
simply want to use the data as

a graphical element, EPS should
be fine.On the other hand, if
you want to edit the data or
interface with a milling machine,
an entirely different file format is
necessary.

What you get in Graphite from
this EPS file may be very different
than what we see on the screen
when we import it because of
your system settings, etc. By
sending us a screen capture we
see what you see.With that, plus
the source and intermediate
files, we have a good chance

of finding where the problem
lies when you tell us your goal.
Follow the rules in the section
below on how to email a file.

For more information on file
translation, see the articles on
our website at http://www.ashlar.
com/sections/support/articles/
articles.html.

Ashlar-Vellum User Newsletter

Movie Files

Another great way to
communicate a problem to us is
to capture it in Cobalt, Xenon or
Argon using Animation>Record
QuickTime. With this we can
follow exactly the steps you took
to encounter the problem. For
Graphite, third-party software
such as Screen Recorder Gold

for Windows or Screen Movie
Recorder for Mac are both
available for under US $30. Movie
files are fairly large so be sure to
follow the directions below for
emailing them to us.

How to Email a File

To send us a file, be sure to
do the following:

1. Put a meaningful name
on the file. Picture14
does not allow us to
know the customer, the
operating system, nor the
issue.

2. Make certain that the file has
a file extension appropriate
to the file. MAC USERS, THIS
MEANS YOU. If it’s a screen
capture, it could be a PDF,
JPG, GIF, PICT or BMP.If it's
an Ashlar-Vellum source
file it could be VC6, CO, XE,
CO AR,VS orVLM.Ifit's a
file you're trying to import
it could be a DXF, DWG,

The Design Explorer
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SAT, IGES or something
else.Whatever the file

type, be absolutely certain
that the file extension is
included.Without it the file
may not transmit reliably
through email and will be
unintelligible when it arrives.

. Send the file as an

attachment to an email.
Don't just paste it in the
body of the email where
most things turn to text.

. While our email system

handles files up to 15 MB
in size, it is good standard
operating procedure to
zip or archive
large files before
emailing.On
Windows use the
built-in ZIP utility
or install WinZip.
On Mac, right click
(or CTRL+click
on a one-button mouse)
and select Create Archive
from the menu. Files that
are compressed using these
programs are encased in
such a way that the email
system can check them for
transmission integrity across
platforms and systems.

Continued...
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5. If your zipped file is
greater than 15 MB
either submit a ticket
to support@ashlar.com
requesting instructions
for using I-DISK or use
the free service at www.
yousendit.com which
allows you to upload
a copy of your file to
their private site and
send us notification
with the instructions
for downloading it. Files
are available for seven
days. (This is also a great
way to exchange large
files with clients and
colleagues.)

Screen Sharing

There are times when a
problem just can’t easily be
solved through email or even
the telephone. At those times,
a screen-sharing session may
be recommended by our
support team using a program
like Acrobat Connect.This
allows us to see the problem
first hand. It also allows us to
fix things on your system that
are incredibly difficult to walk
through with someone on the
telephone.

8 Third Quarter 2007

Service Initiation and
Costs

All support actions MUST start
with a support ticket. Without
a ticket number it is impossible
to track issues effectively and
find problems when email
communications are blocked
through ISPs and junk mail
folders.

To start a support ticket send
an email to support@ashlar.
com or go to our website at
www.ashlar.com and follow
Support>Support Center and
click Submit a Ticket.

Costs for Ashlar-Vellum
technical support services are
on the right:

The Design Explorer
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Email | Phone/Screen

Share
Purchased/ | Free |Free
Shipped
in Past 90
Days
Current Free |[US$39
Version
One Version | Free | US $39
Back
More than | US US $39
One Version | $29
Back
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Right the First Time

When a customer says, “I need it yesterday,“t¥2y can only be
joking, or can they? One Friday morning at Quigley Design a
customer called asking for a rapid prototype to be delivered in
a few days. The customer wanted to assemble the prototype,
including the printed circuit board and other components, in
front of the decision makers in a meeting.

“Fortunately we knew the project well and had produced a series of
concepts by this stage,” said Kevin Quigley, of Quigley Design, “but
the problem was that the required prototype was a completely new
design—and we only had a day to model it!”

Working directly from the customer’s AutoCAD DWG layouts for the
PCB display configuration and envelope, the basic enclosure form was
created with some additional detailing in the handgrip area. Then this
was sent off for approval as a series of photorendered views produced
directly from Cobalt™.

“l always make sure that the parts are modeled with
draft—which is easy to do in Cobalt— so that the
basic form is manufacturable.”

After getting the go ahead, the basic form was split and shelled, then
internal details were added, such as ribs, location pillars for the PCB,
screw bosses, and even a snap fitting battery cover.

By 4:30 the parts were complete, converted to STL (using Cobalt’s built-
in STL export translator) and e-mailed off to the prototyping bureau for
building over the weekend.

A couple of days later the parts arrived, on schedule, at the meeting—
and all the components fit together. “To say | was relieved was an
understatement,” said Kevin, “but the job was done and everyone was
happy—so much so that they decided to chance the design!”

Ashlar-Vellum User Newsletter The Design Explorer

A customer called on Friday morning and
asked for a rapid prototype to be delivered
to a meeting the following Monday, where
the PCB and other components would be
assembled in front of the decision makers.

Background/Contact:
For more details on this project contact:

Quigley Design
Westgate House, Hills Lane,
Shrewsbury, Shropshire, SY1 1QU

Phone: +44 (0) 1743 231661
E-mail: kevin.quigley@kqd.co.uk
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A Sweet First for Starbucks

When David Ryan took on the assignment to create a design
for Starbucks’new line of chocolates, he knew it meant
coming up with a shape that was recognizably Starbucks. It
had to convey a kind of sensuous, playful whimsicality that
people associate with the premier purveyor of coffee and
coffee culture.

Starbucks planned to develop an entire family of chocolates. Not all
the pieces were to be identical, but they were all to be identifiable
as part of the Starbucks chocolate family. This requirement added

to Ryan’s challenge. He had to create a uniquely whimsical, playful
design from which he could spin off a range of shapes that would be
patentable.

When Starbucks asked Ryan to take on the chocolate project, he
chose Ashlar-Vellum™ Cobalt™ to come up with the basic form for
the chocolates—a 3D abstraction of the letter S. Once Starbucks
agreed upon the design, Ryan modeled the shape in the software.
He stated that one of the big advantages of using the Cobalt solid
modeler is the program'’s mass properties function.

“With the solid model | simply supplied the program
with the specific densities of the chocolate and let
it determine the weight automatically. Increasing
or decreasing the weight was done by altering the

geometry.”

Ryan also praised the program’s ability to make rapid prototypes. The
California company that makes foil pieces for wrapping the chocolates
and the German company that makes the candy molds worked
directly from Ashlar-Vellum files to complete their parts of the project.
This, of course, significantly reduced the time from design to finished
product.

Ryan summed it up by saying, “Although it was a first for everyone
involved, the use of CAD and related technologies to create
chocolates turned out to be a very tasty experience.”

1-(800) 877-2745 | www.Ashlar-Vellum.com
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Ashlar-Vellum’s flexibility meant designer
David Ryan could let his imagination

run, but when it came time to get these
chocolates made, wrapped, and at a
Starbucks near you, Cobalt had the power to
finish the job.

The signature ‘S’ design for Starbucks.

Background/Contact:
For more details on this project contact:

David Ryan Design Offices
1061 25th Avenue E
Seattle, WA 98112

Phone: +1 (206) 328-4103
E-mail: davidryan@seanet.com

Copyright Ashlar Incorporated® dba Ashlar-Vellum™ CUSTNEWSA40709. All Rights Reserved. E-mail info@Ashlar.com

Indicated trade names and marks are property of Ashlar Incorporated. All other names and marks are the property of their respective owners. For complete information see www.ashlar-vellum.com/trademarks
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